Color Management

By Martin Evening

The color management system in Photoshop went through many changes in the early years of the program. Bruce Fraser once said of the Photoshop’s color management system ‘it’s push-button simple, as long as you know which of the 60 or so buttons to push and in which order!’ Much have changed since then and it is fair to say that most people working today in the pre-press industry are now using ICC color profile managed workflows without having to think too much about what goes on behind the scenes, so long as it works. The aim of this chapter is to introduce the basic concepts of color management before looking at the color management interface in Photoshop and the various color management settings.
The need for color management

An advertising agency art buyer was once invited to address a meeting of photographers. The chair, Mike Laye, suggested we could ask him anything we wanted, except ‘Would you like to see my book?’ And if he had already seen your book, we couldn’t ask why he hadn’t called it back in. And if he had called it in again we were not allowed to ask why we didn’t get the job. And finally, if we did get the job we were forbidden to ask why the color in the printed ad looked nothing like the original photograph!

That in a nutshell is a problem which has bugged many of us throughout our working lives, and it is one which will be familiar to anyone who has ever experienced the difficulty of matching colors on a computer display with the original or a printed output. Figure 1 shows two versions of the same photograph. The picture on the left shows how you might see an image on your display in Photoshop and the one on the right represents how that same image might print if sent directly to a printer without applying any form of color management. You might think it is merely a matter of making the output color less

Figure 1 The original image is shown on the left. And, on the right, how it might print if you don’t use color management.

Client: Russell Eaton. Model: Lidia @ M&P.
blue in order to successfully match the original. Yes, that would get the colors closer, but when trying to match color between different digital devices, the story is actually a lot more complex than that. The color management system in Photoshop can help you successfully match the colors from the scanner to the computer display and to the printer.

So why can there sometimes be such a marked difference between what is seen on the display and the actual printed result? Well, digital images are essentially nothing more than bunches of numbers. Color management is all about making sense of those numbers and translating them into meaningful colors at the various stages of the image making process.

**Color management objectives**

Successful color management relies on the use of profiles to describe the color handling characteristics of each device, such as a scanner or a printer, and using a color management system to translate the profile data between each device in the chain. Consider for a moment the scale of the task at hand. We wish to capture a full color original subject, digitize it with a scanner or digital camera, examine the resulting image via a computer display and then reproduce it in print. It is possible with today’s technology to simulate the expected print output of a digitized image on a computer display with remarkable accuracy and print with confidence. But in doing so, one should not underestimate the huge difference between the mechanics of all the various bits of equipment that make this process happen. All digital devices have different characteristics, and just like musical instruments, they all possess unique color tonal properties, such that no two devices are absolutely identical or able to reproduce color exactly the same way as another device. The color data you input to the computer has to be translated into illuminated pixels on a color display, so that the image you see on the display looks recognizably the same as what you shot. Finally, at the print stage, the color data has to be converted to reproduce as tiny color ink drops on paper.

Unless you are able to quantify what the individual characteristics are for all your devices, you won’t be able to communicate effectively with other devices and other computer programs in your computer setup, let alone anyone working outside your own system color loop.

Some computer displays have manual controls that allow you to adjust the brightness and contrast (and in some cases the RGB color as well) and the printer driver will also allow you to make color balance adjustments, but is this really enough? Plus, even if you are able to get your display and printer to match, will the colors you see on your display appear the same on another person’s system?

---

**Color vision trickery**

They say that seeing is believing, but nothing could be further from the truth, since there are many interesting quirks and surprises in the way we humans perceive vision. There is an interesting book on this subject titled “Why We See What We Do”, by Dale Purves and R. Beau Lotto (Sinauer Associates, Inc). There is also a website at www.purveslab.net where you can have fun playing with the interactive visual tests, to discover how easily our eyes can be deceived. What you learn from studies like this is that color can never be properly described in absolute mathematical terms. How we perceive a color can also be greatly influenced by the other colors that surround it. This is a factor that designers use when designing a product or a page layout. You also do this every time you evaluate a photograph, often without even being aware of it.
The versatility of RGB

A major advantage of working in RGB is that you can access all the bells and whistles of Photoshop which would otherwise be hidden or grayed out in CMYK mode, and if you choose to use Adobe RGB or ProPhoto RGB, you will have a larger color gamut to work with. These days there is also no telling how a final image may end up being reproduced. A photograph may get used in a variety of ways, with multiple CMYK separations made to suit several types of publications, each requiring a slightly different CMYK conversion (because CMYK is not a ‘one size fits all’ color space). For example, high-end retouching for advertising usage is usually done in RGB mode and the CMYK conversions and film separations are produced working directly from the digital files to suit the various media usages.

Photographers are mainly involved in the RGB capture end of the business, which means that more images than ever before are starting out in, and staying in RGB color. This is an important factor that makes color management so necessary and also one of the reasons why I devote so much attention to the management of RGB color, here and elsewhere in the book. So, if professional photographers are more likely to supply a digital file at the end of a job, how will this fit in with existing repro press workflows that are based on the use of CMYK color? Although digital capture is now commonplace, the RGB to CMYK issue needs to be resolved. If the work you create is intended for print, the conversion from RGB to CMYK must be addressed at some point, and so for this important reason, we shall also be looking at CMYK color conversions in detail later on in this chapter.

Output-centric color management

Printers who work in the repro industry naturally tend to have an ‘output-centric’ view of color management. Their main concern is getting the CMYK color to look right on a CMYK press and printers can color correct a CMYK image ‘by the numbers’ if they wish.

While experienced repro people can make this work for themselves when managing CMYK files, these working methods don’t translate to editing in RGB. Take a look at the photograph in Figure 2. The Caucasian flesh tones of this model should contain equal amounts of magenta and yellow ink, with maybe a slightly greater amount of yellow, while the cyan ink should be a quarter to a third of the magenta. This rule will hold true for most CMYK press conditions and the accompanying table compares the CMYK and RGB space measurements of a flesh tone color. However, you will notice there are no similar formulae that can be used to describe the RGB pixel values.

**Figure 2** This shows the skin tone number measurements for different CMYK and RGB color spaces.

<table>
<thead>
<tr>
<th>CMYK ink values</th>
<th>C</th>
<th>M</th>
<th>Y</th>
<th>K</th>
</tr>
</thead>
<tbody>
<tr>
<td>US Web Uncoated</td>
<td>08</td>
<td>23</td>
<td>29</td>
<td>0</td>
</tr>
<tr>
<td>Euroscale Coated</td>
<td>09</td>
<td>25</td>
<td>30</td>
<td>0</td>
</tr>
<tr>
<td>Japan Pos proofing</td>
<td>07</td>
<td>28</td>
<td>33</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>RGB pixel values</th>
<th>R</th>
<th>G</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe RGB</td>
<td>220</td>
<td>190</td>
<td>165</td>
</tr>
<tr>
<td>Lambda printer</td>
<td>230</td>
<td>184</td>
<td>158</td>
</tr>
<tr>
<td>Epson 9000 RGB</td>
<td>231</td>
<td>179</td>
<td>123</td>
</tr>
</tbody>
</table>
of a flesh tone. If you were to write down the flesh tone numbers for every RGB device color space, you could in theory build an RGB color space reference table. From this you could feasibly construct a system that would assign meaning to these RGB numbers for any given RGB space. This is basically what an ICC profile does except an ICC profile may contain several hundred color reference points. These can then be read and interpreted automatically by the Photoshop software and give meaning to the color numbers.

Profiled color management

The objective of profiled color management is to use the measured characteristics of everything involved in the image editing workflow, from capture through to print, to reliably translate the color at each stage of the process. In a normal Photoshop workflow, the color management begins with reading the profiled RGB color data from the incoming file and, if necessary, converting it to the current Photoshop RGB workspace. While an RGB image is being edited in Photoshop the workspace image data is converted on-the-fly to the profiled display space and sent to the computer display, so that the colors can be viewed correctly. When the image is finally output as a print, the RGB workspace data is converted to the profile space of the printer. Or, you might carry out an RGB to CMYK conversion to the CMYK profile of a known proof printer.

Whether you edit the image in the source profile, or convert to the workspace profile, that profile information should be embedded in an image file. When a profile is read by Photoshop and color management is switched on, Photoshop is automatically able to find out everything it needs to know in order to manage the color correctly from there on. This will also be dependent on you calibrating your display, but essentially all you have to do apart from that is to open the Photoshop Color Settings from the Edit menu and select a suitable preset such as the US Prepress Default setting. Do this and you are all set to start working in an ICC color managed workflow.

Think of a profile as being like a postcode (or ZIP code) for images. For example, the address label shown in Figure 3 was rather optimistically sent to me at ‘Flat 14, London’, but the inclusion of the postcode made all the difference and it arrived safely! Some labs and printers have been known to argue that profiles cause color management problems. This I am afraid is like a courier company explaining that the late arrival of your package was due to you including a ZIP code in the delivery address. A profile can be read or it can be ignored. What is harmful in these circumstances is a recipient who doesn’t use an ICC workflow.
Color Management Modules

At the heart of any ICC system is the Color Management Module, or CMM, which carries out the profile conversion processing.

The International Color Consortium (ICC) is an industry body that represents the leading manufacturers of imaging hardware and software. The ICC grew out of the original Color Consortium that was established in 1993 and has been responsible for extending and developing the original ColorSync architecture to produce the standardized ICC format, which enables profiles created by different vendors to work together. All ICC systems are basically able to translate the color gamut of a source space via a reference space (the Profile Connection Space) and accurately convert these colors to the gamut of the destination space. Although the ICC format specification is standardized, this is one area where there are some subtle differences in the way each CMM handles the data.

In Photoshop you have a choice of three CMMs: Adobe Color Engine (ACE), Apple ColorSync or Apple CMM. There are other brands of CMM that you can use as well, but this really need not concern most Photoshop users, as I recommend you use the default Adobe (ACE) CMM in Photoshop.

The Profile Connection Space

If the CMM is the engine that drives color management, then the Profile Connection Space (PCS) is at the hub of any color management system. The PCS is the translator that interprets the colors from a profiled space and defines them using either a CIE XYZ or CIE LAB color space. The Profile Connection Space is an interim space. It uses unambiguous numerical values to describe color values using a color model that matches the way we humans observe color (see Figure 4). You can think of the PCS as being like the color management equivalent of a multilingual dictionary that can translate one language into any other language.

If an ICC profile is embedded in the file, Photoshop will recognize this and know how to correctly interpret the color data. It helps to understand here that in an ICC color managed workflow in Photoshop, what you see on the display is always a color corrected preview and you are not viewing the actual file data. If color management is switched on, the RGB input profile is read and temporarily converted (as necessary) via the PCS to the RGB workspace. What you then see on the display is an RGB preview that’s converted from the RGB

Translating the color data

One way to comprehend the importance of giving meaning to the numbers in a digital file is to make a comparison with what happens when language loses its meaning. There is an excellent book by Lynne Truss called “Eats, Shoots & Leaves: The Zero Tolerance Approach to Punctuation”. It is partly a rant against poor punctuation, but also stresses the importance of using punctuation to assign exact meaning to the words we read. Remove the punctuation and words can soon lose their true intended meaning. Another good example is the way words can have different meanings in other languages. So a word viewed out of context can be meaningless unless you know the language to which it belongs. For example, the word ‘cane’ in English means ‘dog’ in Italian.
workspace to your profiled display RGB via the PCS (see Figure 5). When you make a print, the image data is converted from the workspace RGB to the printer RGB via the PCS. The same thing happens when Photoshop previews CMYK data on the display. The Photoshop color management system calculates a conversion from the file CMYK space to the display space. Photoshop therefore carries out all its color calculations in a virtual color space. In a sense, it does not necessarily matter which RGB workspace you edit with. It does not have to be exactly the same as the workspace set on another user’s Photoshop system. If you are both viewing the same file, and your displays are correctly calibrated and profiled, a color image should look near enough the same on both. Having said that, the RGB color space selection for the workspace can make a difference to the depth of colors (the color gamut) you have to work with. We’ll be looking at the RGB workspace options towards the end of this chapter.

Figure 5 This diagram shows how the Photoshop color engine uses a Profile Connecting Space to handle the incoming RGB data and translate the data that is displayed on the screen and the data that is sent to the printer.
Profiling the display

To get color management to work in Photoshop you have to calibrate and profile the computer display. This is by far the most important and essential first link in the color management chain. It is after all the instrument you rely upon most when you make your color editing decisions. The display itself is important of course. The cheaper displays tend to have a limited color gamut, are likely to have uneven luminance and may run too bright to calibrate successfully. If you are prepared to spend a bit more money you can get a wide gamut color display that can display more colors and near enough the entire Adobe RGB gamut. Some high-end LCD displays, such as the Eizo ColorEdge and the NEC Spectraview feature hardware level calibration.

I strongly urge you to purchase a display calibration kit that includes the necessary calibration software and use this to calibrate the monitor on a regular basis. In my office I use an X-Rite Eye One device (Figure 6) to calibrate and profile my displays and I use BasIICColor Display software to carry out the calibration process. See the Calibration chapter on the book website for more information about the steps to follow when calibrating and profiling your display. Do remember that the performance of the display will fluctuate over time, so it is therefore important to check and calibrate the display at regular intervals.

Profiling the input

Input profiling is possible, but it’s easier to do with a scanner than it is with a digital camera. To profile a scanner you’ll need to scan a film or print target and use profile creation software such as X-Rite’s i1 Profiler™ program to read the data and build a custom profile based on readings taken from the scanned target (Figure 7). The target measurements are then used to build a profile that describes the characteristics of the scanner. It can then be incorporated into your color managed workflow to interpret the color image data coming into Photoshop. This can be done by selecting the profile in the scanner software or by assigning the profile in Photoshop as the file is opened.

Camera profiling is a lot trickier to do. This is because the camera sensor will respond differently under different lighting conditions and you would therefore need to build a new profile every time the light changed. This is not necessarily a problem if you are using a digital camera in a studio setup with a consistent strobe lighting setup. As you will recall in the Camera Raw chapter, Camera Raw has built-in ‘Adobe Standard’ camera profiles for all supported cameras.
Where required, you can include an X-Rite ColorChecker in a setup, photograph this and use the Adobe DNG Profile Editor app to generate a custom camera profile for that specific camera and lighting setup.

Overall, I would not stress too much about input profiles unless this is something that is critical to your workflow that you have absolute color control from start to finish. Most photographers can successfully rely on the Adobe Camera Raw Adobe Standard profile to get the colors looking correct. Once you start editing a photo it is more important to trust what you see on your monitor display and obtain good color management between the image that’s previewed on the computer display and what you see in print.

Profiling the output

Successful color management also relies on having accurate profiles for each type of media paper that’s used with your printer. If you buy a desktop printer it should come with a driver on a CD, or one you can download. The installation procedure should install a set of canned profiles that will work when using the proprietary inks designed to be used with the printer and for a limited range of branded papers. The canned profiles are generally good enough for professional print results. However, you can carry out custom profiling to build profiles for other types of print/paper combinations. This can be done by printing out a test target like the one shown in Figure 8, but without color managing it. This can be done by downloading the Adobe Color Printer Utility from the Adobe website (tinyurl.com/25onde3). Use this to print the supplied target. Once the test print has been allowed to stabilize, it can be measured the following day with a device like the X-Rite Eye-One spectrophotometer (Figure 9). The patch measurement results can then be used to build a color profile for the printer. The other alternative is to take advantage of Neil Barstow’s remote profiling service special offer which is available to readers (see the back of the book). You can use a profiled printer to achieve good CMYK proofing, even from a modestly priced printer, which comes close to matching the quality of a recognized contract proof printer.

Figure 8 An X-Rite color target that can be used to build an ICC color profile.

Figure 9. Once a printed profile has been printed out, the color patches can be read using a spectrophotometer and the measurements used to build an ICC profile.
Color management in action

Figure 10 re-examines the problem encountered at the beginning of this chapter where the skin tones in the original image printed too blue. In this workflow no printer profile was used and the image data was sent directly to the printer with no adjustment made to the image data. Figure 11 shows a profile color managed workflow and what happens behind the scenes when Photoshop carries out a color profile conversion. The profile created for this particular printer is used to convert the image data to that of the printer’s color space before being sent to the printer. The (normally hidden) color shifting which occurs during the profile conversion process ensures the output more closely matches the original.

Figure 10 This shows an example of a non-color managed workflow.

Figure 11 This shows an example of a Photoshop color managed workflow.
The Color Settings

The Color Settings (Figure 12) are located in the Edit menu. The first item you will come across is the Settings pop-up menu. Photoshop provides a range of preset configurations for the color management system and these can be edited to meet your own specific requirements. The default setting will be a General Purpose setting and the exact naming and subsequent settings list will vary depending on the region where you live. Since this is just a default I advise changing this to one of the prepress settings. This selects Adobe RGB as your RGB workspace, and enables the Profile Mismatch and Missing Profiles alert warnings. So if you live in Europe, you would select the ‘Europe Prepress’ setting from the Settings options shown in Figure 13. The prepress’ settings are an ideal starting point for any type of color managed workflow, especially if you are a photographer. This is all you need to concern yourself with initially for a nice and easy simple color management setup that is good to go. However, if you want to learn more about how color management works and what the various settings do, then read on.

Figure 12 The Color Settings dialog.

Figure 13 The Settings menu options in Color Setting.
Color management policies

The first thing Photoshop does when a document is opened is check to see if an ICC profile is present. The default policy is to preserve the embedded profile information. So whether the document has originated in sRGB, Adobe RGB or ColorMatch RGB, it will open in that RGB color space and after editing be saved as such. This means you can have several files open at once and each can be in an entirely different color space. A good tip here is to set the Status box to show 'Document profile' (on the Mac this is at the bottom left of the image window; on a PC it is at the bottom of the system screen). Or, you can configure the Info panel to display this information. This allows you to see each individual document’s color space profile.

Preserve embedded profiles

The default policy of ‘Preserve Embedded Profiles’ allows you to use the ICC color management system straight away, without too much difficulty. So long as there is a profile tag embedded in any file you open, Photoshop gives you the option to open that file without converting it. So if you are given an sRGB file to open, the default option is to open it in sRGB and save using the same sRGB color space. This is despite the fact that your default RGB workspace might be ProPhoto RGB or some other RGB color space. The same policy rules apply to CMYK and grayscale files. Whenever ‘Preserve Embedded Profiles’ is selected, Photoshop reads the CMYK or Grayscale profile, preserves the numeric data and does not convert the colors, and the image remains in the tagged color space. This is always going to be the preferred option when editing incoming CMYK files because a CMYK file may already be targeted for a specific press output and you don’t really want to convert and alter the numbers for those color values.

Profile mismatches and missing profiles

The default prepress color management policy setting is set to ‘Ask When Opening’ if there is a profile mismatch (see Figure 14). This means you will see the warning dialog shown in Figure 15 whenever the profile of a file you are opening does not match the current workspace. This offers you a chance to use the embedded profile (which is recommended). Or, you can override the policy and convert to the working space, or discard the embedded profile. Whatever you do, select one of these options and click OK, because if you click ‘Cancel’ you’ll cancel opening the file completely. I normally select Preserve Embedded Profiles and deselect ‘Ask When Opening’, so I am not constantly shown this dialog.
A newcomer does not necessarily have to fully understand how Photoshop color management works in order to use it successfully. When ‘Preserve Embedded Profiles’ is selected this makes the Photoshop color management system quite foolproof and the color management system is adaptable enough to suit the needs of all Photoshop users, regardless of their skill levels. Whichever option you select – convert or don’t convert – the saved file will always be tagged with a correct ICC profile.

Figure 14 The Color Management Policies, with the Profile Mismatches and Missing Profiles checkboxes checked.

Figure 15 The Embedded Profile Mismatch dialog.
**Convert to Working space**

If you select the ‘Convert to Working RGB’ policy, Photoshop automatically converts everything to your current RGB workspace. If the incoming profile does not match the workspace and the Ask When Opening option is unchecked, the default option is to carry out a profile conversion from the embedded profile space to the current workspace (as shown in Figure 16). Here, you can click OK to convert to the current work space. If the ‘Ask When Opening’ box is checked in the Profile Mismatches section you will see the dialog shown in Figure 17. Here, you can make a choice on opening to use the embedded profile, convert to the working space, or override the policy and discard the embedded profile. If the incoming profile matches the current RGB workspace, there will of course no need to convert the colors.

The same applies when selecting the ‘Convert to Working CMYK’ policy. However, in the case of CMYK files it is inadvisable to convert to the CMYK working space because once a file has been converted to CMYK it is best not to reconvert to CMYK again.

![Figure 16 The Embedded Profile Mismatch dialog.](image)

![Figure 17 The Embedded Profile Mismatch dialog when ‘Ask When Opening’ is checked in Color Settings.](image)
**Color Management Off**

When the ‘Off’ option is selected Photoshop appears not to color manage incoming documents and assumes the default RGB or CMYK workspace to be the source. If there is no profile embedded, the document opens ‘as is’. If there is a profile mismatch between the source and the workspace, you’ll see the dialog shown in Figure 18, which points out that if you click OK the embedded profile will be deleted. If the ‘Ask When Opening’ box is checked in the Profile Mismatches section, you will see the options shown on Figure 19.

If the source profile matches the workspace, there is no need to remove the profile. In this instance the profile tag will not be removed (even so, you can still remove the ICC profile at the save stage). Therefore, Photoshop is still able to color manage certain files and strictly speaking is not completely ‘off’. Turning the color management off is not recommended for general Photoshop work. If working on an unfamiliar computer, do check the Color Settings to make sure Photoshop’s color management hasn’t been disabled.

---

**When it is good to ‘turn off’**

Sometimes it is desirable to discard a profile. For example, you may be aware that the image you are about to open has an incorrect profile and it is therefore a good thing to discard it and assign the correct profile later in Photoshop. I still would not recommend choosing ‘Off’ as the default setting though. Just make sure you have the Color Management Policies set to ‘Ask When Opening’ and you can easily intervene and discard the profile when using the ‘Preserve Embedded Profiles’ or ‘Convert to Working’ RGB color management policies settings.

---

**Figure 18** The Embedded Profile Mismatch dialog when Color Management is set to Off.

**Figure 19** The Embedded Profile Mismatch dialog when Color Management is set to Off and ‘Ask When Opening’ is checked in Color Settings.
Profile conversions

As you gain more experience you will soon be able to create your own customized color settings. The minimum you need to know is ‘which of the listed color settings are appropriate for the work you are doing’. To help in this decision making, you can read the text descriptions that appear in the Description box at the bottom of the Color Settings dialog. The following section explains how to make profile conversions once files have been opened in Photoshop, as well as how to assign different profiles where it is necessary to do so.

Convert to Profile

Even if you choose to preserve the embedded profile on opening, it can be useful to convert non-workspace files to your current workspace after opening. This is where the Convert to Profile command comes in, because you can use it to carry out a profile conversion at any time, such as at the end of a retouch session, just before saving. To do this, go to the Edit menu and choose ‘Convert to Profile…’ (Figure 20). The Source space shows the current profile space. In Basic mode, the Destination Space defaults to ‘Working RGB’. Or, you can change this, as I have done here to sRGB.

Click on the Advanced button to go to the Convert to Profile Advanced dialog (Figure 21). Here, the Destination space options are broken down into different color mode types: Gray, RGB, Lab and CMYK, plus other more esoteric options such as Device Link and Abstract profile modes. With the color modes segmented this way, it

RGB to RGB conversion warning

A Convert to Profile is just like any other image mode change in Photoshop, such as converting from RGB to Grayscale mode. However, if you use Convert to Profile to produce targeted RGB outputs don’t overwrite the original RGB master. As always, customized RGB files such as this may easily confuse other non-ICC savvy Photoshop users. Not everyone is using Photoshop, nor does everyone have their color management configured correctly. RGB to RGB conversions can produce RGB images that look fine on a correctly configured system, but look very odd on one that is not.

Figure 20 The Basic Convert to Profile dialog.
makes it easier to access specific types of profiles when carrying out a conversion. Also, when you select from the RGB menu you only see RGB spaces and if you click on the CMYK menu you only see the CMYK space options (see Figure 22).

The Convert to Profile command is most commonly used when converting photographs to sRGB for the Web, or converting to a specific CMYK color space (which isn’t the same as the default CMYK space). It is also useful whenever you wish to create an output file to send to a printer for which you have a custom-built profile but the print driver does not recognize ICC profiles. You can record the Convert to Profile as an Action step when batch processing images where you wish them to all be converted to a specific color space.

Be aware that whenever you make a profile conversion the image data will end up in a different color space and you might therefore see a slight change in the on-screen color appearance. This is because the profile space you are converting to may have a smaller gamut than the one you are converting from.

Also, whenever you open an image in Photoshop that is in a color space other than the default working space, or you convert to a different working space, Photoshop appends a warning asterisk (*) to the color mode in the title bar (Mac) or status bar (PC).
Assign Profile

If an image is missing its profile or has the wrong profile embedded, the color numbers will be meaningless. In these situations the Assign Profile command (Figure 23) can be used to correct such mistakes and assign a correct meaning to the numbers. For example, if you know the profile of an opened file is wrong, you can use the Edit ➞ Assign Profile command to rectify the problem. Or, let’s say you have opened an untagged RGB file and for some reason decided not to color manage the file when opening. The colors don’t look right and you have reason to believe that the file had originated from the sRGB color space. Yet, it is being edited in your current ProPhoto RGB workspace as if it were a ProPhoto RGB image. By assigning an sRGB profile, you can tell Photoshop that this is not a ProPhoto RGB image and the numbers should be interpreted as being in the sRGB color space.

In most instances, assigning sRGB will bring the colors back to life. For example, whenever I get sent an unprofiled file, in just about every case I can successfully correct the image by assuming the missing profile to be sRGB.

You can also use Assign Profile to remove a profile by clicking on the Don’t Color Manage This Document button. This strips the file of its profile. You can also do this by choosing File ➞ Save As… and deselecting the Embed Profile checkbox in the Save options.

Profile mismatches when pasting

It is possible to have multiple images open in Photoshop that have different profiled color spaces. Therefore, whenever you copy and paste image data, or drag a layer from one image to another, it is possible for a profile mismatch may occur; although this will very much depend on how you have the Color Management policies configured in the Color Settings (see Figure 24).

If the Profile Mismatches: Ask When Pasting box is unchecked in the Color Settings and a profile mismatch occurs, you will see the dialog

Incorrect sRGB profile tags

Some digital cameras won’t embed a profile in the JPEG capture files or worse still, embed a wrong profile, yet the EXIF metadata will misleadingly say the file is in sRGB color mode. The danger here is that while you may select Adobe RGB as the RGB space for your camera, when shooting in JPEG mode the camera may inadvertently omit to alter the EXIF tag which stubbornly reads sRGB. This can be resolved by going to the Photoshop menu and choosing: Preferences ➞ File Handling… If you check the ‘Ignore EXIF Profile tag’ option, Photoshop always ignores the specified camera profile in the EXIF metadata and only relies on the actual profile (where present) when determining the color space the data should be in.
The Profile Mismatches settings in the Color Management section of the Color Settings dialog will influence Profile Mismatch behavior.

shown in Figure 25. This asks if you wish to convert the color data to preserve the color appearance when it is pasted into the new destination document. If the Profile Mismatches: Ask When Pasting box is checked in the Color Settings, then you will see the dialog box shown in Figure 26. This offers you the choice to convert or not convert the data. If you select 'Convert', the appearance of the colors will be maintained when you paste the data and if you choose 'Don't Convert' the color appearance will change but the numbers will be preserved.

Figure 24 The Profile Mismatches settings in the Color Management section of the Color Settings dialog will influence Profile Mismatch behavior.

Figure 25 The Paste Profile Mismatch dialog.

Figure 26 The Paste Profile Mismatch dialog when Ask When Pasting is checked in Color Settings.
Once you have configured the settings to suit a particular workflow, you can click on the Save… button in the Color Settings dialog to save these as a custom setting. The directory path will be: Username/Library/Application Support/Adobe/Color/Settings (Mac), or Program Files/Common Files/Adobe/Color/Settings folder (PC). When you save a custom setting it must be saved to this location and will automatically be appended with the ‘.csf’ suffix.

When you save a setting you can enter any relevant comments or notes about the setting you are saving in the text box shown in Figure 27. This information will then appear in the Color Settings dialog text box at the bottom. You might name a setting something like ‘Client annual report settings’ and write a short descriptive note to accompany it, reminding you of situations where you would need to use this particular custom setting. Color Settings files can also be shared between some Adobe applications and with other Photoshop users.

Figure 27 The Color Settings Comment dialog

Reducing the opportunities for error

When you adopt an RGB space such as ProPhoto RGB as the preferred workspace for all your image editing, you must take into account how this might cause confusion when exchanging RGB files between your computer (which is operating in a color managed workflow) and that of someone who might be using Photoshop with the color management switched off. When sending image files to other Photoshop users, the presence of a profile can help them read the image data correctly, so long as they have the Photoshop color settings configured to preserve embedded profiles (or convert to the working space) and their computer display is calibrated correctly. They will then see your photographs on their system almost exactly the way you intended them to be seen. The only variables will be the accuracy of their display calibration and profile, the color gamut limitations of the
display and the environment in which it is being viewed. Configuring the Color Settings is not so difficult to do, but the recipient does have to be as conscientious as you are about ensuring their display is correctly calibrated.

It is important to be aware of these potential problems because it is all too easy for the color management to fail once an image file has left your hands and been passed on to another Photoshop user. With this in mind, here are some useful tips to help avoid misunderstandings over color. The most obvious way to communicate what the colors are supposed to look like is to supply a printed output. If you are sending a file for CMYK repro printing, it is sensible to also supply a CMYK targeted print output. Supplying a print is an unambiguous visual reference, which if done properly can form the basis of a contract between yourself, the client and the printer.

You cannot always make too many assumptions about who you are sending image files to and it is for this reason that you should sometimes adopt a more cautious approach. I have often asked to supply RGB files as JPEGs for initial approval by the client before making a finished print. In these situations I find it safer to supply a profiled sRGB image. I do this by choosing Edit ➞ Convert to Profile… and select sRGB as the destination space. If the recipient is color management savvy, then the version of Photoshop they are working with will be able to read the sRGB profile and handle the colors correctly. If not, one can be almost certain that they are using sRGB as their default RGB workspace. So in these instances, converting to sRGB means they stand a better chance of seeing the colors correctly regardless of whether they have the color management on or off.

Playing detective

Whenever you have to share files with another Photoshop user it helps to do a little detective work to ascertain the recipient’s setup. For example, you might want to ask what color settings are they using? This will help you determine which RGB space they are using and whether the color management is switched on or off. You can also ask if computer display is calibrated and profiled?’ This will tell you quite a bit about the other person’s system, how accurate their computer display is at displaying colors and therefore how you should supply your files. Some printing labs specify that the files you supply must be converted to a specific profile space. If so, make sure you do this rather than rely on having them convert the file for you. Other than that, sRGB is a useful ‘dumbed down’ space to convert to when communicating with unknown users. If you have any doubts, the safest option is always to convert to sRGB before sending.
Conversion options

The Color Settings dialog is shown below in Figure 28. In the Conversion Options section you have a choice of three Color Management Modules (CMMs). I recommend you leave this set to the Adobe Color Engine (ACE), which uses 20-bit per channel bit-depth calculations to calculate its color space conversions. But you can if you like select the Apple CMM ColorSync engine.

![Color Settings dialog](image)

**Figure 28** The Color Settings dialog.

Rendering intent

The rendering intent influences the way the data is translated from the source to the destination space. The rendering intent is like a rule that describes the way the conversion is calculated. Whenever you make a profile conversion, such as when converting from RGB to CMYK, not all of the colors in the original source space will have a direct equivalent in the destination space. RGB spaces are mostly bigger than CMYK,
or an RGB print space, which can result in colors in the source space being out of gamut relative to the destination space. In these situations the out of gamut colors have to be translated to their nearest equivalent color in the destination space. The way this translation is calculated is determined by the rendering intent. The Color Settings dialog lets you choose which rendering intent (Intent) you would like to use as the default method for all color mode conversions (Figure 29), but you can also override this setting and choose a different rendering intent whenever you use the Edit ➔ Convert to Profile command (Figure 30), or soft proof an image using View ➔ Proof Setup ➔ Custom. The latter lets you preview a simulated conversion without actually converting the RGB data.

**Perceptual**

The Perceptual rendering is an all-round rendering method that is sometimes suitable for certain types of images. Perceptual rendering compresses the out-of-gamut colors into the gamut of the target space in a rather generalized way (so that they don’t become clipped), while preserving the visual relationship between those colors. More compression occurs with the out-of-gamut colors, smoothly ramping to no compression for the in-gamut colors. Perceptual rendering provides a best guess method for converting out-of-gamut colors where it is important to preserve tonal separation (such as in the shadow detail areas), but it is less suitable for images that happen to have fewer out-of-gamut colors.

**Saturation**

The Saturation rendering intent preserves the saturation of the out-of-gamut colors at the expense of hue and lightness. Saturation rendering preserves the saturation of colors making them appear as vivid as possible after the conversion. This rendering intent is best suited to the conversion of business graphic presentations where retaining bright bold colors is of prime importance.

**Relative Colorimetric**

Relative Colorimetric is the default rendering intent utilized in the Photoshop color settings. Relative Colorimetric rendering maps the colors that are out of gamut in the source color space (relative to the target space) to the nearest ‘in-gamut’ equivalent in the target space. For example, when doing an RGB to CMYK conversion, an out-of-gamut blue will be rendered the same CMYK value as a ‘just-in-gamut’ blue and out-of-gamut RGB colors are therefore clipped. This can be a
problem when attempting to convert the more extreme out-of-gamut RGB colors to CMYK color, but if you use View ⇒ Proof Setup ⇒ Custom (Figure 31) to call up the Customize Proof Condition dialog you can check to see if such gamut clipping will cause the loss of any important image detail when converting to CMYK with a Relative Colorimetric conversion.

![Figure 31 The Customize Proof Condition dialog](image)

### Which rendering intent is best?

If you are converting photographic images from one color space to another, then you should mostly use the Relative Colorimetric or Perceptual rendering intents. Relative Colorimetric has always been the default Photoshop rendering intent and is still the best choice for most image conversions. However, if you are converting an image where it is important to preserve the shadow colors, then Perceptual may often be better. For these reasons, I recommend you use the Soft proofing method described in the Print chapter to preview the outcome of a profile conversion.

---

**Absolute Colorimetric**

Absolute Colorimetric maps in-gamut colors exactly from one space to another with no adjustment made to the white and black points. This rendering intent can be used when you convert specific ‘signature colors’ and need to preserve the exact hue, saturation and brightness (such as the colors in a commercial logo design). This rendering intent is seemingly more relevant to the working needs of designers than photographers. However, you can use the Absolute Colorimetric rendering intent as a means of simulating a target CMYK output on a proofing device. Let’s say you make a conversion from RGB to CMYK using either the Relative Colorimetric or Perceptual CMM and the target CMYK output is a newspaper color supplement printed on uncoated paper. If you use the Absolute Colorimetric rendering intent to convert these ‘targeted’ CMYK colors to the color space of the proofing device, the proof printer can reproduce a simulation of what the printed output on that stock will look like. For example, when you select the ‘Proof’ option in the Photoshop print dialog, the rendering intent menu appears grayed out. This is because an Absolute Colorimetric rendering is selected automatically (although the Print dialog doesn’t actually show you this) in order to produce a simulated proof print.
Figures 32 to 34 illustrate how the rendering intent can influence the outcome of a color mode or profile conversion. Figure 32 shows the Adobe RGB color space (represented by a mesh shape) overlaying a US Sheetfed Coated CMYK color space (represented as a solid shape). Adobe RGB is able to contain all the colors that may be squeezed into this smaller CMYK space. The palm tree photograph is plotted as dots to represent where the RGB colors in this image fall within the Adobe RGB space gamut.

When the colors in this RGB image are converted to CMYK, the rendering intent determines how the RGB colors that are outside the gamut limits of the CMYK space are assigned a new color value. If you turn over the page you will notice the subtle differences between a relative colorimetric (Figure 33) and a perceptual (Figure 34) rendering (I have highlighted a single blue color in each to point out these differences). With a Relative Colorimetric rendering the out-of-gamut blue color is rendered to the nearest in-gamut CMYK equivalent. With a Perceptual rendering the same blue color is squeezed in further. This rendering method preserves the relationship between the out-of-gamut colors but at the expense of sometimes (but not always) producing a less vibrant separation.

**Figure 32** The colors in this photograph are represented here as dots within the Adobe RGB space color gamut, which is compared with the smaller CMYK output gamut.
**Figure 33** Relative Colorimetric rendering intent.

**Figure 34** Perceptual rendering intent.
Black Point Compensation

This maps the darkest neutral color of the source RGB color space to the darkest neutrals of the destination color space. Black Point Compensation plays a vital role in translating the blacks in your images so that they reproduce as black when printed. As was explained in Chapter 2, there is no need to get hung up on setting the shadow point to anything other than zero RGB values. It is not necessary to apply any shadow compensation at the image editing stage, because the color management will automatically take care of this for you and apply a black point compensation obtained from the output profile used in the mode or profile conversion. If you disable Black Point Compensation you may obtain deep blacks, but you will get truer (compensated) blacks if you leave it switched on.

You will want to use Black Point Compensation when separating an RGB image to a press CMYK color space. However, in the case of a conversion from a CMYK proofing space to an inkjet profile space, we must preserve the (grayish) black of the press and not scale the image (because this would attempt to correct the blacks). For this reason Black Point Compensation is disabled in the Print dialog when making a proof print to simulate the black ink and how light the blackest colors will print.

Use Dither (8-bit per channel images)

Banding may occasionally occur when you separate to CMYK, particularly where there is a gentle tonal gradation in bright saturated areas. Any banding which appears on the display won’t necessarily always show in print and much will depend on the coarseness of the screen that’s eventually used in the printing process. However, the dither option can help reduce the risk of banding when converting between color spaces.

Scene-referred profiles

The Compensate for Scene-referred Profiles option isn’t of any real significance for photographers. It is switched on by default and designed to automatically apply video contrast when converting between scene and output-referred profiles. This basically matches the default color management workflow for After Effects CS4 or later.
Advanced controls

Desaturate Monitor Colors

The ‘Desaturate Monitor Colors’ option can be used to visualize and make comparisons between color gamut spaces where one or more gamut space is larger than the display RGB space. For example, a color spaces such as ProPhoto RGB has a gamut that is much larger than the computer display is able to show. So turning down the monitor colors saturation can allow you to make a comparative evaluation between these two different color spaces. It is in essence a ‘hurt me’ button, because if you don’t understand how to use this feature, you might inadvertently leave it on and end up assuming all your images are desaturated.

Blend RGB Colors using Gamma

This option lets you override the default color blending behavior. There used to be an option in Photoshop 2.5 for applying blend color gamma compensation. This allowed you to blend colors with a gamma of 1.0, which some experts argued was a purer way of doing things, because at higher gamma values than this you might see edge darkening occur between contrasting colors. Some users found the phenomenon of these edge artifacts to have a desirable trapping effect. However, many Photoshop users complained that they noticed light halos appearing around objects when blending colors at a gamma of 1.0. Consequently, gamma-compensated blending was removed at the time of the version 2.5.1 update, but has since been restored as an adjustable option. So, if you understand these implications you can enable and adjust this setting if you wish. Figure 35 shows a pure RGB green soft-edged

Figure 35 Comparing Blend RGB Colors using Gamma.
brush stroke on a layer above a pure RGB red Background layer. The version on the left shows the layer appearance using the normal default blending. The version on the right shows what happens when I checked the Blend RGB Colors using Gamma option and applied a gamma of 1.0.

The Blend Text Colors Using Gamma option is always checked by default with a setting of 1.45 to provide optimum blending for vector text layers. This value is chosen for vector shapes and text to make the anti-aliasing look better.

**Custom RGB and work space gamma**

If you know what you are doing and wish to create a customized RGB color space, you can do so by selecting the Custom option in the pop-up menu. Having done this, enter the desired White Point, Gamma and color primaries coordinates (Figure 36). My advice is to leave these expert settings well alone. Avoid falling into the trap of thinking that the RGB workspace gamma should be adjusted to be the same as the monitor display gamma setting. The RGB workspace is not a display space. You do not actually 'see' the RGB workspace and the gamma setting has no effect on how the colors are displayed on the screen (so long as Photoshop ICC color management is switched on). All good reasons why the custom color space options are safely tucked away in Color Settings. The settings shown in Figure 36 are those needed to define 'Bruce RGB', named after Bruce Fraser who once devised this color space as a suggested prepress RGB space for Photoshop.

Adobe RGB is considered a good choice as an RGB workspace because its 2.2 gamma provides a more balanced, even distribution of tones between the shadows and highlights, while others, prefer the 1.8 gamma ProPhoto RGB space for its wide color gamut.
CMYK conversions

Print images are nearly always reproduced in CMYK. Since the conversion from RGB to CMYK has to happen at some stage, the question is: at what point should this take place and who should be responsible for the conversion? If you have decided to take on this responsibility yourself then you need to understand more about the CMYK settings. When it comes to four-color print reproduction, it is important to know as much as possible about the intended press conditions that will be used at the printing stage and use this information to create a customized CMYK setup.

CMYK setup

If you examine the US prepress default setting, the CMYK space says ‘U.S. Web Coated (SWOP) v2’. This setting is by no means a precise setting for every US prepress SWOP coated print job, because there can be many flavors of SWOP, but it does at least bring you a little closer to the type of specification a printer in the US might require for printing on coated paper with a web press setup. If you mouse down on the CMYK setup pop-up list, you will see there are also US options for Web uncoated and Sheetfed press setups. Under the European prepress default setting, there is a choice between coated and uncoated paper stocks, plus the latest ISO coated FOGRA39 setting. Then there is also Custom CMYK… where you can create and save custom CMYK profile settings.

There is not a lot you can do with the standard CMYK settings: you can essentially choose from this handful of generic CMYK profile settings or choose ‘Custom CMYK…’ If you check the More options box, you’ll be able to select from a more comprehensive list of CMYK profile settings in the extended menu (depending on what profiles are already in your ColorSync folder).

Creating a custom CMYK setting

Figure 37 shows how to select the Custom CMYK option, along with the Custom CMYK dialog, where you can enter all the relevant CMYK separation information for a specific print job. Ideally you should save each purpose-built CMYK configuration as separate color settings with a description of the print job it was created for.

Once you have configured a new CMYK workspace setting, this becomes the new default CMYK workspace that is used when you convert an image to CMYK mode. Altering the CMYK setup

Saving custom CMYK settings

Custom CMYK settings should be saved using the following locations:
Library/ColorSync/Profiles/Recommended folder (Mac OS X);
Windows\System32\Spool\Drivers\Color folder (PC).
settings will have no effect on the on-screen appearance of an already-converted CMYK file). This is because the CMYK separation setup settings must be established first before you carry out the conversion.

Figure 37  The Custom CMYK menu option (left) and Custom CMYK dialog (right).

**Ink Colors**

If you click on the Ink Colors menu, you can select one of the preset Ink Colors settings that are suggested for different types of printing. For example, European Photoshop users can choose from Eurostandard (coated), (uncoated), or (newsprint). These are just generic ink sets though. If your printer can supply you with a custom ink color setting, then select ‘Custom…’ from the Ink Colors menu. This opens the custom Ink Colors dialog shown in Figure 38.

Figure 38  The Ink Colors dialog.

**Specialist Ink Colors options**

For special print jobs such as where non-standard ink sets are used, or the printing is being done on colored paper, you can enter the measured readings of the color patches (listed here) taken from a printed sample on the actual stock that is to be used. For example, you could measure these printed patches with a device such as the X-Rite Eye-One and use this information to create a custom Ink Colors setting for an individual CMYK press setup.
**Dot gain**

Dot gain can be due to an accumulation of factors during the repro process that make a dot printed on the page gain size and appear darker than expected. Among other things, dot gain is dependent on the type of press and the paper stock that's being used. The dot gain value entered in the CMYK setup determines how light or dark the separation needs to be. If a high dot gain is encountered, the separated CMYK films will need to be less dense so the plates produced lay down less ink on the paper and produce the correct-sized printed halftone dot for that particular type of press setup. Although the dot gain value affects the lightness of the individual channels, the composite CMYK channel image is always displayed correctly on the screen, showing how the final printed image should look.

If you select the 'Dot Gain Curves' option, you can enter custom settings for the composite or individual color plates in the Dot Gain Curves dialog (Figure 39). If your printer is able to provide dot gain values at certain percentages, enter these here. The dot gain curves can be the same for all channels, but since the dot gain may vary on each ink plate, you can enter dot gain values for each plate individually.

**Comparing dot gain settings**

You can see for yourself how the dot gain values affect the CMYK separations. Try converting an image to CMYK using two different dot gain values and then compare the appearance of the individual CMYK channels.

---

**Gray Component Replacement (GCR)**

The default Photoshop CMYK setting is GCR, Black Generation: Medium, Black Ink Limit 100%, Total Ink Limit 300%, UCA Amount 0%. If you ask your printer what separation settings they use and they quote you these figures, you’ll know they are just reading the default settings from an unconfigured Photoshop setup. They either don’t know or don’t want to give you an answer. The black ink limit should typically be around 95% for most separation jobs, but in the region of 85–95% for newsprint. The total ink limit should roughly be in the region of 300–350% for Sheetfed coated and Web press coated jobs, 260–300%
for Sheetfed uncoated and Web uncoated jobs, and 260–280% for newsprint. If you prefer, you can just stick to using the prepress CMYK setting that most closely matches the output (such as US Sheetfed/Web Coated/Uncoated, or one of the European FOGRA settings).

**Black Generation**

The Black Generation determines how much black ink is used to produce the black and gray tonal information. A light or medium Black Generation setting will work best for most photographic images. I would therefore advise leaving this set to ‘Medium’ and only change the black generation if you know what you are doing.

You may be interested to know that I specifically used a Maximum Black Generation setting to separate all the dialog boxes that appear in this book. Figure 40 shows a view of the Channels panel after I had separated the screen grab shown in Figure 38 using a Maximum Black Generation CMYK separation. With this separation method only the black plate is used to render the neutral gray colors. Consequently, this means that any color shift at the printing stage has no impact whatsoever on the neutrality of the gray content. I cheekily suggest you inspect other Photoshop books and judge if their panel and dialog box screen shots have reproduced as well as the ones shown in this book.

**Undercolor Addition (UCA)**

Low key subjects and high quality print jobs are more suited to the use of GCR (Gray Component Replacement) with a small amount of UCA (Undercolor Addition). GCR separations remove more of the cyan, magenta and yellow ink where all three inks are used to produce a color, replacing the overlapping color with black ink. By dialing in some UCA one can add a small amount of color back into the shadows. This can be particularly useful where the shadow detail would otherwise look too flat and lifeless. The percentage of black ink used is determined by the black generation setting. When making conversions, you are usually better off sticking with the default GCR, using a light to medium black generation with 5–10% UCA. This will produce a longer black curve with improved image contrast.

**Undercolor Removal (UCR)**

The UCR (Undercolor Removal) separation method replaces the cyan, magenta and yellow ink with black ink in just the neutral areas. The UCR setting is also favored as a means of keeping the total ink percentage down on high-speed presses, although it is not necessarily suited for every type of print job.

---

**CMYK previews in Proof Setup**

Once the CMYK setup has been configured, you can use View ➔ Proof Setup ➔ Working CMYK to see a CMYK preview of what a photograph will look like after a CMYK conversion, while you are still editing the image in RGB mode.

**Figure 40** Here is a view of the Channels panel showing the four CMYK channels after I had separated the screen grab shown in Figure 38 using a Maximum black generation CMYK separation.
Choosing a suitable RGB workspace

The RGB space you choose to edit with can certainly influence the outcome of your CMYK conversions, which is why you should choose your RGB workspace carefully. The default sRGB color space is widely regarded as an unsuitable space for photographic work because the color gamut of sRGB is actually smaller than the color gamut of CMYK (and that of most inkjet printers). If you choose a color space like Adobe RGB or ProPhoto RGB, you’ll be working with a color space that can adequately convert from RGB to CMYK without significantly clipping the CMYK colors. Adobe RGB has long been a favoured space for professional photographers and you should really notice the difference here if you are able to view the photos you are editing on a decent display like the high-end Eizo or NEC displays. These are capable of displaying something like 98% of the Adobe RGB gamut and therefore just about all the gamut of a typical CMYK space. It can make a big difference if you can use such a display to accurately preview the colors you are editing and soft proof them for print (see Chapter 12).

Whichever color workspace you select in the RGB color settings, you will have to be conscious of how your profiled Photoshop RGB files may appear on a non-ICC savvy Photoshop system. What follows is a guide to the listed RGB choices.

Apple RGB

This is the old Apple 13” monitor standard. In the early days of Photoshop Apple RGB was used as the default RGB editing space where the editing space was the same as the monitor space. If you have legacy images created in Photoshop on a Macintosh computer using a gamma of 1.8, you can assume Apple RGB to be the missing profile space.

sRGB IEC-61966-2.1

sRGB was conceived as a multipurpose color space standard that consumer digital devices could all standardize to. It is essentially a compromise color space that provides a uniform color space which all digital cameras and inkjet printers and displays are able to match (since sRGB aims to match the color gamut of a typical 2.2 gamma PC display). Therefore, if you are opening a file from a consumer digital camera or scanner and there is no profile embedded, you can assume that the missing profile should be sRGB. It is an ideal color space for Web design but unsuitable for photography or serious print work. This is mainly because the sRGB space clips the CMYK gamut quite severely and you will never achieve more than 75–85% cyan in your CMYK separations.

CMYK to CMYK

It is not ideal for CMYK files to be converted to RGB and then converted back to CMYK, as this is a sure-fire way to lose data fast. I always prefer to keep an RGB master of each image and convert to CMYK using a custom conversion to suit each individual print output. Converting from one CMYK space to another is not really recommended either, but in the absence of an RGB master, this will be the only option you have available: just specify the CMYK profile you wish to convert to in the Convert to Profile dialog box. Remember, the Preserve Embedded Profiles policy ensures that tagged incoming CMYK files can always be opened without converting them to your default CMYK space (because that would be a bad thing to do). This means that the color numbers in the incoming CMYK files are always preserved, while providing you with an accurate display of the colors on the computer display.
**ColorMatch RGB**

ColorMatch is an open-standard RGB display space that was once implemented by Radius, who used to make displays and graphics cards for the Macintosh computer market. ColorMatch has a gamma of 1.8 and is still favored by some Macintosh users as their preferred RGB working space. Although not much larger than the gamut of a typical display space, it is at least a known standard and more compatible with legacy 1.8 gamma Macintosh files. The problem with selecting a small gamut space like this means you end up losing tonal separation in colors that may be important, such as when carrying out an RGB to CMYK conversion.

**Adobe RGB (1998)**

Adobe RGB (1998) has become established as a recommended RGB editing space for RGB files that are destined to be converted to CMYK. For example, the Photoshop prepress color settings all use Adobe RGB as the default RGB working space. Adobe RGB was initially labeled as SMPTE-240M, which was a color gamut once proposed for HDTV production. As it happens, the coordinates Adobe used did not exactly match the actual SMPTE-240M specification. Nevertheless, it proved popular as an editing space for repro work and soon became known as Adobe RGB (1998). I have in the past used Adobe RGB as my preferred RGB working space, since it is well suited for RGB to CMYK color conversions.

**ProPhoto RGB**

This is a large gamut RGB space that has the advantage of preserving the full gamut of raw capture files when converting the raw data to RGB. It is also suited for image editing that is intended for output to photographic materials such as transparency emulsion or a photo quality inkjet printer. This is because the gamut of ProPhoto RGB extends more into the shadow areas compared with most other RGB spaces, resulting in better tonal separation in the shadow tones.

I have ProPhoto RGB configured as the RGB work space on all my computers running Photoshop and normally carry out all my editing on RGB files in 16-bit. However, I am wary of releasing files to clients in ProPhoto RGB. If I am sending a file to someone who I believe is ICC color management savvy, I’ll send them a profiled Adobe RGB version. If I am sending a file by email or to someone who may not understand color management, I always play safe and send them an sRGB version.
Lab color

The Lab color space does not use embedded profiles since it is assumed to be a universally understood color space. It is argued by some that converting to Lab mode is one way to surmount all the problems of mismatched RGB color spaces. You could make this work, but I don’t personally advise this for a number of reasons. In fact, a few readers have taken me to task over not covering Lab mode image editing in this book, so let me clarify why I don’t see editing in Lab mode as being so useful now for high-end image editing. In the early days of Photoshop I would sometimes use the Lab color mode to carry out certain tasks, such as to separately sharpen the Lightness channel. This was before the introduction of layers and blending modes, where I soon learnt you could use the Luminosity and Color blend modes to neatly target the luminosity or the color values in an image without having to convert to Lab mode and back to RGB again. Also, with Camera Raw the sharpening is applied to the luminance values only and it is possible to further filter the sharpening using the Detail and Masking sliders.

Let’s just say that there are no right or wrong answers here. If you can produce good-looking prints using whatever methods work best for you, and you are happy with the results, well who is to argue with that? However, I would hope by now that having learnt about optimizing tones and colors in Camera Raw, followed by what can be achieved using Photoshop, you’ll realize that these are all the tools you’ll ever need to process a photograph all the way through to the finished print stage. My response to the Lab color argument is that it is simply adding complexity where none is needed. There are good reasons why in recent years the Adobe engineering teams have devoted considerable effort to enhancing the Camera Raw image editing for Photoshop and Lightroom. Their aim has been to make photographic image editing more versatile, less destructive and above all, simpler to work with rather than rely on cumbersome workarounds.

Measuring by the numbers

Given the deficiencies of typical computer color displays, such as their limited dynamic range and inability to reproduce certain colors like pure yellow, color professionals may sometimes rely on the numeric information to assess an image. Certainly, when it comes to getting the correct output of neutral tones, it is possible to predict with greater accuracy the neutrality of a gray tone by measuring the color values with the eyedropper tool. If you use the eyedropper tool to measure the colors in an image that’s in a standard RGB space, such as sRGB, Adobe RGB or ProPhoto RGB, and the RGB numbers are all equal, it is unquestionably a gray color. Figure 41 shows an eyedropper...
measurement being taken from a white balance card. The even RGB values indicate that this light gray color is perfectly neutral in color.

Interpreting the CMYK ink values is less straightforward. This is because a neutral CMYK gray is not made up of an equal amount of cyan, yellow and magenta. If you compare the Color readout values between the RGB and CMYK Info panel readouts, there will always be more cyan ink used in the neutral tones, compared with the yellow and magenta inks. This is because a greater proportion of cyan ink is required to balance out the magenta and yellow inks to produce a neutral gray color in print (if the CMY values were equal, you would see a muddy brown color cast). This is due to the fact that the process cyan ink is less able to absorb its complementary color – red – compared with the way magenta and yellow absorb their complementary colors. This also explains why a CMY black will tend to look reddish/brown, without the addition of the black plate to add depth and neutrality.

When retouching a portrait (such as in the Figure 42 example), you can use the Info panel CMYK readout numbers to help judge if the skin tones are the correct color. To do this set the panel options to display RGB and CMYK readouts. Then use the eyedropper to measure the skin tone values. Caucasian skin tones should have roughly a third or a quarter as much cyan as magenta and slightly more yellow than magenta. Black skin tones should be denser, have the same proportion of cyan to magenta, but usually a higher amount of yellow than magenta and also some black.

**Color management references**

If your main area of business revolves around the preparation of CMYK separations for print, then I do recommend you invest in a training course or book that deals with CMYK repro issues. I highly recommend the following books: *Real World Color Management* by Bruce Fraser, Chris Murphy and Fred Bunting; *Color Management for Photographers* by Andrew Rodney; and *Getting Colour Right, The Complete Guide to Digital Colour Correction* by Neil Barstow and Michael Walker. And lastly, an easy-to-follow ebook guide called *Accurate Color*, an interactive guide by Herb Paynter.

![Figure 42 You can use the CMYK values in the Info panel to help check if the skin tones are the correct color by comparing the percentage of cyan with the magenta and yellow inks.](image)
Keeping it simple

Congratulations on making it through to the end of this chapter. Your head may be reeling from all this information about Photoshop's color management system, but successful color management doesn't have to be complex. Firstly, you need to set the Color Settings to the prepress setting for your geographic region. This single step configures the color management system with the best defaults for photographic work. The other thing you must do of course is to calibrate and profile the display. If you want to do this right, you owe it to yourself to purchase a decent colorimeter device and ensure the computer display is profiled regularly. Do just these few things and you are well on your way to achieving a reliable color management workflow. However, color management can't always be expected to yield perfect results. The ability to match colors between capture and print is ultimately dependent on the gamut limits of the display and output device. This is a subject I will be addressing further in the following chapter on print output.

768 pages + Online website
Order via Focal Press secure online ordering: www.routledge.com
For more information go to the book website: www.photoshopforphotographers.com